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COMMAND.COM
By Andy Toth, President

The Annual Meeting of the Channel Islands Personal
Computer User Group will be in June. Election of officers
also takes place at the meeting.
As of this writing there is not a candidate for president. It
might prove to be an interesting election.
It looks like there will not be voting on the Web site. If
you wish to cast a vote, it is best you attend.
Hope a quorum can be reached.

Also on the inside:

Do you know what’s on your computer?
Photo by Jerry Crocker

Vivitar digital cameras and
other products were the topic
of the May program. For a report on the program, see page
8. And for a further discussion
of digital photography, see the
article by Bob de Violini that
starts on page 9.
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That was the question at the Beginner’s SIG last month,
and if your answer is no, you should find out what the
group learned. — Page 10

Quicken makes tracking money easy

Check out a review of the latest version of the popular
financial program. — Page 12

Nameplate has a new look

The editor’s corner tells where the idea came from. —
Page 18
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Society news: Coming up

Encryption program coming in June
Programs
This month’s meeting on Saturday,
June 7, will feature Andrew De Ponte,
discussing Enigma II, an encryption
program by JP Cybertech.
As usual, the meeting will be in
Freedom Center at Camarillo Airport
(see map and schedule on back page).
Here is a description from the company’s Web site
“Enigma II is an advance encoding
software that encrypts your personal
information so you can safely store it
in your own home computer!! Each
piece of information is stored separately in different accounts. And each
account has four entries, account
name, number, user name, and password making sure that you can easily
store anything from computer user
names, passwords, credit card nu mbers, membership numbers and much
more. Enigma II also allows you to
easily add, delete, or edit any accounts.
Enigma I makes your life much
easier because you only have to re member one password in order to access your personal accounts. The information is always saved in encrypted
form inside your computer. And don't
worry about hackers trying to decrypt
your information because every time
you exit Enigma II, the software reencrypts every account with a different
encryption from the one used before!
“At the heart of Enigma II lies our
own Alpha-Encryptor, a powerful 800bit encryption engine. This encryption
engine gives hackers 1 x10100 possible combinations to decrypt the information (by the way that's a one follow
by 100 zeros!). But that's not all, our
Alpha-Encryption engine has the ability to generate other 800-bit algorithms. So for maximum protection
against hackers, our Alpha-Encryption
engine encrypts every field in every
account with a different 800-b i t encryption algorithm.”
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July 5: Garage Sale
The fourth annual Garage Sale of
the Channel Islands PC Users Group
will be held from 8:30 to 10:30 a.m.
during our monthly general meeting,
on Saturday, July 5, and this year, your
fellow members are offering a wide
selection of used software and hardware items.
A small sample of the software
programs includes computer games,
photo editing, etc., and some of the
hardware items are keyboards, monitors, hard drives, printers, etc. In addition, Ventura County Computers will
be offering several new products at
discounted prices.
The latest CIPCUG CD containing
the member-recommended freeware
and shareware programs and the popular book “The Secret Guide To Co mputers” will be available.
At this meeting, the Beginner’s
and Internet SIGs will begin at their
usual time and following the Ga rage
Sale will be the usual business meeting, the general Q&A session (in lieu
of the regular monthly computer
manufacturer/distributor presentation),
and the raffle of new and unsold donated Garage Sale items. At this meeting only, there will be no Library services.
Bring your non-member friends to
this meeting for them to learn of the
advantages of being a member and
they, of course, may participate as buyers in the Garage Sale.
The agenda for this special meeting will be:
8:30 a.m.: Doors open and seller
tables are set up
8:30-10:15 a.m.: Garage Sale
8:45-9:30 a.m.: Beginner’s and
Internet SIGs
10-10:30 a.m.: Coffee break
10:15 a.m.: Selling stops and vendor tables are removed
10:30-10:45 a.m.: Business meeting
10:45-11:45 a.m.: Q&A

The Outer Edge

June door prizes
The club door prizes for June are:
Sidewinder Precision Racing
Wheel
WinFax Pro
Liteon CD Rewriter 48x24x48x
Cable/DSL Broadband Router,
Print Server Included
Additional prizes might be added
before the meeting.
We have two types of raffle tickets:
one for any prizes offered by the presenter and one for club-provided
prizes.
The tickets for the presenter’s
prizes are free and limited to one per
member.
The tickets for the club-provided
prizes are $1 each, $5 for six tickets,
$10 for 13 tickets and $20 for 26 tickets and are available to anyone.

SIG reminders
available by e-mail
To keep members up to date on
coming SIGs, Andy Toth has agreed
to offer an e-mail reminder service to
club members.
Sign up and he will automatically
send you a reminder about two days
before each SIG, indicating the topic,
location, and date.
To sign up, send an e-mail to
<siglist@cipcug.org> with the subject
line “subscribe.”

11:45-Noon: Raffle
Noon: Meeting ends
Sellers’ tables are available to display your items for sale. The individual tables are approximately 2 feet
wide and 6 feet long and you may request either a whole table or a fraction
of a table (a half of table, a third, a
fourth, etc.). The tables are assigned as
first come, first served. Five percent of
(Continued on page 4)
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More on coming programs and SIGs...
(Continued from page 3)

the price of all sold items goes to the
club’s treasury to help keep your annual membership dues low.
A new feature this year is the cosigner table, where you may drop off
your items for sale and need not personally be at a table during the entire
Garage Sale selling period. The fee for
this service is 10 percent of the sold
price.
Please contact Jim Thornton, CIPCUG Garage Sale coordinator
(jthorn@gte.net), before July 1, to reserve your table, as space is limited as
in previous years.

Aug. 2: Dave Whittle
Dave will discuss a variety of programs, including the following, according to his e-mail:
iSeeMedia: Photovista, Photovista
Virtual Tour and/or Reality Studio.
iSeeMedia is a Roxio spinoff headed
by MGI’s former CEO, Anthony DiCristofaro, devoted to development
and marketing of exciting new image
technologies, including panoramas and
fully immersive interactive visual reality.
USA Micro Research Institute —
3D Album
At COMDEX, even jaded industry
professionals crowded around MRI’s
booth clamoring to buy 3D Album,
with its eye-popping visuals. 3D Album is attracting all kinds of media
attention for its ability to easily create
fascinating 3D slide shows of digital
pictures. Even ordinary pictures can be
transformed into an enthralling display
that family and friends will be eager to
see.
Black Cat Media Associates Muvee, Mivee Autoproducer
Muvee is a young company with a

killer technology and product that enables you to make your home movies
watchable in record time and with outstanding simplicity. Its Artistic Intelligence includes Smart Cuts to automatically trim and summarize your
video, smartAnalyze to look for key
moments and remove low-quality
video, smartSync to synchronize the
effects and transitions with your music, and smartStyle to almost instantly
create finished videos in a wide choice
of styles.
Alpha 5 - Alpha 5 Version 5
For beginners and experts alike,
Alpha 5 V5 provides elegant ease of
use with all the power you’ll ever need
for managing data.
If you have a program request or
suggestion, give it to Craig Ladd by email (vicepresident@cipcug.org) or at
any meeting.

SIGs
Specia l Interest Groups (SIGs)
meet at Ventura County Computers in
Ventura. From the 101 Freeway, exit
at Telephone, take Telephone south to
McGrath, turn left and go one block.
Turn right on Goodyear and then right
again into the second driveway. Unit
117 is the back, right corner of the in dustrial building.
SIGs are sponsored by CIPCUG
and led by volunteers. There is no
charge for members to attend.
If no moderator is listed, the SIG is
not officially scheduled. Check the
Web page before you attend.
Unless otherwise noted, SIGs run
from 6:30 to 8:30 p.m.
Here’s the SIG schedule for the end
of May and all of June:
Thursday, May 29: Andy Toth.
The general Q&A last month was so

well received that he has decided to try
it again. This will just be a good oldfashioned Q&A. Anything you have
always wanted to know but never got
your hand up in time at the Saturday
meetings.
Monday, June 9: Michael
Shalkey — Tips & Tricks for every
program in your computer. Michael
will be showing us things that we may
have forgotten were available to us. In
word processors and data bases, little
things like “quick text and/or macros”
are extremely useful. Many different
programs have the same Key Coding
shortcuts. Those function keys were
created for a purpose and we should all
be familiar with what they are.
Thursday, June 19: Toby Scott —
Handling Broadband. We are going to
cover setting up a cable/DSL router:
How to set up static, dynamic and
PPPoE IP addresses; how to check
your connection; how to troubleshoot
connectivity problems; how to set up
your home network behind the router;
how to set up services for remote access; how to open up ports for specific
programs like PC Anywhere and how
to make your network safer.
Thursday, June 26: Andy Toth —
A One to One comparison of OpenOffice and Microsoft Office: WordWriter, Excel- Calc, PowerPoint Presentation, Access-??, and ??-Draw.
The comparison will be interesting.
The invitation is out to anyone who
would like to lead a SIG to volunteer
to do so.
You don’t have to be an expert in a
program. You just need enough exp erience with it to show off some of the
basic features.
For more details, talk to anyone
who has presented a SIG or to any officer.

Be sure to attend the June meeting so we will have a
quorum for the election.
Page 4
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Society news: Business meeting, Q&A session

Keep that recycling going
Reported by Martha
Churchyard
Business meeting summary
The officers gave their regular re ports, which are detailed elsewhere in
the newsletter.
The club received over $500 for the
last batch of recycled printer cartridges. Helen has posted the criteria
for the cartridges the recycler will accept on the Web site at the bottom of
the “Behind the Scenes 3” page. The
item “Recycle” on the main menu goes
directly to that page. These payments
will be a good source of income now
that CIPCUG must start paying rent
for a meeting space, if we can all pitch
in and contribute cartridges.
Helen also would like to put names
on the photos of all the raffle prizewin ners. If you recognize any faces, please
let her know. Some people were given
the wrong address to send ISP payments. They should go to the club box,
P.O. Box 51354 in Oxnard, not John
Weigle’s P. O. Box in Ventura.
John Weigle announced that the
copy of Flight Simulator that was raffled off was sent to us by Microsoft to
use as a review copy. John would like
the winner to please contact him about
doing a review for the TOE.
Bob de Violini mentioned a Web
site that has a lot of good information
on DSL, including testing your down-

load and upload speeds: www.
dslreports.com.
Andy announced that the board
had toured the Camarillo Boys & Girls
Club for use as a new meeting site, and
it looks good. At its next meeting the
board will vote formally to start meeting there in September.
The election for club officers will
be held at the June general meeting.
All the current officers have agreed to
continue in their positions, except the
president. The by-laws limit the president’s term, so the board is looking for
a new president. If you are interested,
please contact a member of the board.
It does not require technical expertise,
just some basic people skills.

Q & A SESSION
Unless otherwise noted, comments
and answers are from Toby Scott.
Fradulent PayPal site
Before we begin, there are a couple
of items. How many of you subscribe
to PayPal? Be awa re that there is a
scam going around where some people
in Russia created a Web site that looks
exactly like the PayPal Web site. They
send you an e-mail asking you as a
PayPal subscriber to verify your account again because of inactivity or
some such excuse. They request your
credit card information, bank account
numbers, Social Security number, etc,
etc. The explanation is very plausible,

and they even say they are not asking
you to e-mail this information, just to
fill it in on the site. The return address
is spoofed very cleverly to look like the
PayPal address, and the page when you
get there looks exactly like the PayPal
site. Needless to say, if you do go
there, your accounts will be cleaned
out forthwith.
Stopping telemarketers
There is a way to stop telemarketing calls by placing three tones at the
beginning of your call-answering ma chine message. The Web site www.
flash.net/~carlton2/telemark.htm will
help you do this.
Note: This Web site can be difficult
to reach. A quick Google search turned
up some sites that recommend either
buying a little box that plays the three
tones, or configuring Caller ID blocking with an extra monthly charge:
http://markson.net/telespam.htm;
http://caeaudio.com/devices.html. The
site http://web.morons.org/feature/
telespam.jsp, once you get past the
profanity, has an MPG tone file you
can record on your answering ma chine. The Web site http://
antitelemarketer.bizland.com/
index2k18x6.htm has a lot of good
info and a tone file, but it doesn’t
seem to recommend using it.
SIG on building a computer?
Someone asked about having a SIG
(Continued on page 6)

Executive Committee Meeting Notes
May 2003
The CIPCUG Steering Committee
meeting was held on May 6,2003, at
the home of Andy Toth.
Present: George Lakes, Helen
Long, Andy Toth, Toby Scott, Ralph
Duchacek, Ken Church, Craig Ladd
and Art Lewis.
Dates and subjects for June SIGs
were discussed.
June 2003

By Martha Churchyard, secretary

The question came up whether the
club would continue to meet on the
first Saturday of the month after the
move to the Boys & Girls Club. After
discussion, it was agreed to leave it on
the first Saturday. Once or twice a year
there will be a conflict, and those
meet ings can be held on the second
Saturday.
The Outer Edge

Helen Long made a motion to ac cept the Camarillo Boys & Girls Club
as CIPCUG’s new meeting place. The
motion was seconded by Ralph Duchacek and was approved unanimously.
Ken and Art gave their reports, and
Craig reported on possible presenters
for coming programs.
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More Q&A: XP not shutting down properly
(Continued from page 5)

to build your own computer. He remembered when you could buy a
Heathkit and build your own. Back in
1983, I bought one and built a computer from scratch. It took only 10,000
solder joints to solder the motherboard
together. You can’t do that any more.
That was only a four-layer motherboard. Now they are up to 12 layers. It
takes a wave solderer to get deep in side, a microwave type of thing, a
wave oven.
We won’t be able to get that detailed, but there could be a SIG that
provided a bench so that you could
bring your own components and get
help putting them together. How many
are interested? (Several people raise
their hands.) OK, I’ll come with a proposal and a sign-up sheet next time. In
the meantime, if any of you who are
interested have any ideas about how
this should be done, e-mail me.
XP shutdown problems
Q: Last night my computer was
working just fine until I went to shut
down XP. The screen grayed, but nothing happened. I was able to hit the
power button, and it went into hiberna tion and came back fine, but nothing
happened when I used the shutdown
button.
A: When you have trouble with XP
shutdown, it’s not like Windows 98
where you can just turn it off. With XP
that’s not a good idea. What you want
to do is hit Ctrl-Alt-Delete, which will
pop up a little window, the Task Man ager. It shows the programs that are
running and their status – “running.”
When you can’t close down, where it
usually says “running” after the program name, it will say, “not responding.” That means you have a program
that is not responding to the Windows
shutdown command. Generally, you
can highlight that task and then click
on the “End Task” button. It will ask
you to confirm, and when you have
finished shutting down those programs
you should be able to shut down your
computer.
Page 6

Task Manager Processes tab
Q: I did that, but there was nothing
running.
A: Then that takes you to Plan B.
On the Task Manager, go to the Processes tab, and just start shutting them
down. Some of them are system processes that you can’t shut down, but
others can be.
Q: Can you highlight them all and
shut them down all at once?
A: No, just one at a time. You can
get some idea what is causing the
problem by looking at the CPU usage
column. Notice the System Idle process, here it’s 99 percent, meaning that
basically the computer is doing nothing. Start shutting them down, and
eventually you will be able to shut
down the computer.
Many people don’t know this, but
with a modern computer if you just
press the on/off button nothing happens, or it goes into sleep mode, depending on how you have the computer configured. You have to hold the
button in for 10 or 15 seconds to actually turn off.
It would be a good idea to run
Checkdsk. Remember, with Windows
3.1 it was Checkdsk and then they
came up with a new and improved
Scandisk for Windows 95/98, and they
told you not to use Checkdsk any
more. Now they’re back to Checkdsk.
If you go to checkdsk the C: drive, it
will say it can’t do it now because
you’re using it, it will check it when
you reboot.
What is pctspk.exe?
From audience: In regard to ending
processes, there’s a process called
Pctspk.exe that goes occasionally to
100 percent and stays there for a long
time. It’s some kind of voice application. There is actually quite a bit about
it in “Windows Annoyances,” but you
can just get rid of it.
AMD 64-bit processor
Q: I understand that AMD has
come out with a new 64-bit processor.
Any general information or comments
on that?
The Outer Edge

A: I don’t think it’s out yet. Beta
copies are out. (Correction: it is out
now.) But since it’s coming, let’s talk
a little bit about 64-bit processing. It
will be a revolution in computing. At
the present time, in 32 bits, the code
pages, mapping the keyboard to various character sets, you have to do what
they call keyboard overlays. For English you have the Western European
keyboard overlay, Russia has the Cyrillic keyboard overlay, Japan has the
Kanji overlay, and so on. To actually
see those characters, you have to go to
the Microsoft Update site and download the language you want. But there
is not enough room in 32 bits to have
all of those potential keystrokes all
mapped to one clock cycle. For technical reasons, nobody wants to have two
clock cycles used.
It will also make a difference for
accuracy of computation of certain
very large numbers. Some of us that do
relatively large spreadsheets can occasionally end up with round-off errors.
Technically you can go to 64 bits by
having each function be two clock cycles long, but then the computer runs
at half the speed. So with 64 bits any
language can be displayed, numerical
precision will be higher, and twice as
much data can be transmitted in one
clock cycle — actually more than double, you square it. Computers will be
much more powerful. It will mean
fairly usable speech recognition, much
more natural, because it can do much
finer sample rates. You will be able to
speak relatively naturally and the computer will transcribe what you say.
AMD is coming out with the 64-bit
processor that will be backwardly compatible with Windows XP and Win dows programs. Essentially what it
does is just act as a 32-bit processor.
A 32-bit operating system only passes
32 bits per clock cycle to the processor.
The only way to take advantage of 64bit processing is with a 64-bit operating system. They actually have had 64bit chips for a while, but there aren’t
(Continued on page 7)
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More Q&A: Missing VXD files, moving programs
(Continued from page 6)

many operating systems that will use
them.
The initial application for the 64bit processors is going to be for very
large-scale computers where they will
put 48 processors or so on a motherboard with some kind of super architecture and do very large-scale engineering projects.
Eventually it will come down to the
desktop, and programs will be written
in 64-bit code that we can actually use.
But the first AMD 64-bit chips will
probably go to gamers or people who
are beta-testing their own software, or
something like that.
It is on the horizon, but the biggest
problem is infrastructure: You need
operating systems, programs, stuff that
can take advantage of all the extra capabilities. Because of that, everything
you use has to be rewritten, and that’s
not going to happen overnight. We
won’t benefit from the new chips for
two, three, maybe four years.
The primary reason AMD has
come out with backwards compatibility
with Windows is marketing. AMD is
hoping by having backward compatibility that they can steal market share
from Intel. Coming out with it now is
99 percent marketing and 1 percent
technology.
Windo ws can’t find VXD file
Q: When I start Windows I get a
message that a file needed by the system cannot be found. It is a VXD file.
But Windows is able to start anyway.
A: Go to your win.ini or system.ini
and see if you can find it there. If not,
do a registry search and see where it is
called, what program it is associated
with. Reinstall the program, if you use
it. If it’s not a program you use, go
ahead and delete the reference. As
usual, the caveats are to back up your
registry.
Would Regcleaner work?
From audience: Would Regcleaner
from the club CD work in this case?
A: It might work, but no program
will get them all. Certainly try them
June 2003

out before you do a manual search.
Can software relocate programs?
Q: I’ve heard of a program that
will let you transfer programs and files
from one computer to another, implying that you wouldn’t have to reinstall
any programs on the new target ma chine.
A: First of all, I’ve never heard of
the product. It is possible to do it, but
I’m not sure how reliably and I’m not
sure how effectively. I’ve done it
manually, twice, with mixed results,
and I can’t really recommend it. You
can go into the registry and find the
area that a particular program installed
to, and export just that one key, that
one part of the registry, to a file. Then
you import that file to the registry on
the new computer, and you have all
the registry settings for the program.
Then you copy the files over into the
same directory structure that it had
before, and it will run. So a program
could do that. Personally I would
rather reinstall the program, but sometimes if the disks are lost, or whatever,
and there is a program that does that,
it might be better at finding all the registry entries than a manual search
would be.
(Bob de Violini provided this information after the meeting: Here is the
link to the PC transfer program that
someone asked about at the meeting. It
is called Alohabob PC Relocator, or
PC Relocater for short.
It will do transfers from Win
95/98/Me etc. to Win XP, etc. And it
apparently will copy all programs —
but not operating systems — from a
lower OS PC to a higher OS PC. There
is a three-day free trial of the download version. If not using a USB
hookup, you need a parallel transfer
cable as from a Laplink kit. Very good
reviews of it. The basic program
($29.95) does things pretty much automatically. The Ultra version ($69.95)
lets the user be selective about what
gets transferred and has some other
goodies.
(Go to : http://www.eisenworld.
The Outer Edge

com/ProductsHome.asp.
(It is also available at Office Depot,
Staples, Best Buy and CompUSA.
(Another program is called Stepup
PC. It also will go to Win XP from
earlier OSs. But it is limited in which
programs it will handle — mostly Microsoft programs and a select few of
other programs. Its price starts at
$29.95 downloaded and in four steps,
up to $59.95 with other cables, etc.
(Its Web site is at http://www.
technopundits.com/stepup.htm.
(Looks like a poor imitation of and
not as capable as the AlohaBob program.)
Can sound cards just die?
Q: A few days ago my sound quit
working, and what I think happened is
my sound card died. I took off the
case, pulled the card out and put it
back in again, and still had no sound.
Can a sound card just die like that?
A: Yes, it’s possible, but let’s try
streamlining the diagnostic tools.
First, if the sound icon in the system
tray disappears, go to the Sound icon
in Control Panel, and there is a check
box that says, “show the sound icon in
the system tray.” Be sure that box is
checked. If it is grayed out, it means
Windows can’t see the sound card. If it
doesn’t see the sound card, go to Device Manager in Windows 98, rightclick on My Computer, and go to
Properties, then the Device Manager
tab, and look for the lovely yellow exclamation mark. That tells you that
what was installed is no longer functioning correctly. It could be hardware,
but it could also be a driver problem.
What I would do at this point, if it has
the yellow exclamation point, is to reinstall the driver, particularly if you
have the CD for the sound card, or if
it’s onboard sound, the motherboard
CD. Go into the Properties for the device; there is a tab for drivers, and on
there is a place to reinstall or update
the driver. If that doesn’t work, see if
there is an updated file on the Internet.
If all that fails, then I would open the
(Continued on page 8)
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Program: Vivitar

Digital photography replacing film
By John Weigle
jweigle@vcnet.com
Digital photography is fast replacing film cameras, Thomas Piehn, director of imaging technologies and
Web initiatives at Vivitar, said at our
last meeting. The split is about 80 percent digital and 20 percent film, he
said.
The Newbury Park company,
which is celebrating its 65th year in
business, is finding that more and
more of its business is moving to digital cameras and away from film, he
said, especially as improved technology brings prices down. The company
produces point and shoot camera, digital cameras, specialty cameras, SLR
cameras, projectors, flashes, sports optics, night vision scopes and accessories.
The Web site – http://vivitar.com –
is an online catalog of products, and
Piehn walked us through the product
line using one of the new digital projectors, which, he said, will be “an up
and coming business for us; it’s a little
bit pricey right now.”
The company has also developed a
digital flash specifically for digital
cameras.
Vivitar is doing a complete remake
of its binocular line, and older models
are being blown out on the company’s
eBay store, he said.
“We’ve sold over 100 million cameras in the last 10 years,” he said.
“We’re moving into the digital camera
area. Last year we did about 750,000,
this year probably 1 million or so just
in digital.”

Photo by Jerry Crocker

Thomas Piehn, director of
imaging technologies and
Web initiatives for Vivitar,
shows one of the company’s cameras while
standing behind a blowup of a picture taken with
a digital camera
Digital cameras are encroaching on
the company’s zoom cameras and
other sales, he said, so the product line
is being reduced. Digital cameras are
available in 5, 4, 3, 2 and 1 megapixels, although the 5-megapixel showpiece won’t be available until August
or September.
The type of camera you need depends on what you’re going to do with
it, he said, but most people can get by
with a 4-megapixel or less (the 3megapixel is the current hot spot, he
said). Prices vary because “we tailor
our models to our retailers, so whatever they want, we’ll put one together

for them.” Wal-Mart, Staples and Target are among the stores selling the
Vivitar cameras. Piehn uses a 3.3megapixel camera with a 3X optical
zoom for most of his Web work. He
adjusts lighting and crop pictures in
Photoshop.
The Web site has a gallery of pictures for each digital camera it lists so
potential buyers can see the results
they can get. “The real proof is in the
picture,” he commented, and the cameras are priced appropriately for their
performance.
Digital cameras use two different
technologies for sensors, CCD and
CMOS, he said. CCD is Japanesebased and CMOS is U.S./British/
Israel-based. All of the 1-megapixel
and some of the 2-megapixel cameras
are CMOS, with the others being
CCD. The CMOS sensors are less expensive to build but they do have some
inherent deficiencies when shooting in
low light and have less crisp color.
Only three co mpanies, Panasonic,
Sharp and Sony, make the CCD system, with Sony doing about 80 percent
of the business and keeping the prices
up, he said. Because of the politics and
price issues, “we’ve tended to go with
the CMOS solution,” he said.
The sensors make it difficult to use
single-lens reflex lenses, he said, and
cameras that can use the SLR lenses
don’t get the full field of view that the
film camera would.
A 3-megapixel CMOS camera is
expected in four to six months, he
(Continued on page 9)

More on Q&A...
(Continued from page 7)

case and press it down. If that doesn’t
work, the next thing I would do would
be to go back into Device Manager and
delete the device to force Windows to
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redetect it.
From audience: On Windows 98
SE I had the same problem. I plugged
in the headphones, which drops out
the speakers, and when I pulled out the
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headphone it didn’t reconnect to the
speakers again. In frustration I tried
everything. Finally when I pulled the
sound card out and put it back it made
the connection again.

June 2003

Advice

No-hype sources of information
about digital photography
By Robert de Violini
dviolini@adelphia.net
At the end of Tom Piehn’s interesting presentation about the Vivitar
Camera line of digital products, I went
up to the front table to see the samples
he brought. I was surprised by the
lightness — probably because of the
plastics involved — when compared
with the Olympus D-550 Zoom digital
camera, for instance (8.5 oz). Of
course, these were all the lower end of
their line — no zoom capability that I
saw, so no motor, for instance, and
without batteries, which can add an other 3.5 ounces to them. But they
looked pretty good for the jobs they
were designed for.
Someone asked Tom about ISO
values (the current term for the old
ASA film speed ratings) for the sensors the Vivitar used. He said they

Fig. 1: This is the initial screen on the Short Courses site.
were all ISO 100. That must have referred only to the Vivitar line, because
the Olympus — and I believe that
most all mid-range and beyond cameras — have the capability to be used
with their sensors at ISO 100, 200 and
400 speeds. So not all are restricted to

ISO 100 speeds.
Tom was fielding lots of questions
and one of the members, whose name I
did not get, was asking some good
technical questions about the variation
in methods of figuring focal length
(Continued on page 14)

More on Vivitar’s digital cameras ...
(Continued from page 8)

said.
The new digital flash is expected to
be a big seller, Piehn said. The key is
to synchronize the flash and the camera because all the cameras are different.
The flash will remember each camera, but it forgets the settings when
you turn it off, “which is good because
you can use it with any camera,” he
explained.
“ You’ll find that the flashes built
into most digital cameras are pretty
weak. They’re there because people
want them.” By the end of the year, he
expects three digital flashes to be
available.
Digital binoculars combine a camera and binocular optics, although
you’re not shooting through the optics
of the binoculars. “School is still out
June 2003

on how useful this is going to be,” he
said, partly because of the movement
problems. A tripod socket should help
solve that, however, he said.
Vivitar is also working on a fixedfocus “tiny, tiny camcorder that will
record on a compact flash card.” Resolving the MPEG4 compression technology standards are fully developed
and accepted. It will probably be
priced in the $250-$300 range, he
said.
A member asked about battery
needs, and Piehn said the development
of new batteries has helped the digital
camera industry because of longer battery life. Cameras have also decreased
their power needs.
The digital projectors are still expensive, he said. Six digital projectors
are available. Model numbers are close
to the lumens output, he explained,
The Outer Edge

although the DP1500 is an 1,800 ul men projector. The SVGA projects 800
by 500 while the XGA is 1,024 by 768.
The DP1500 costs about $3,000 with
the next model being about $2,300.
Prices should fall to about $900 in a
year or so, he said.
“The cameras are pretty good about
capturing the color,” he said. Most of
the cameras allow manual settings or
the automatic settings. But users can
also tell the camera if the picture is
being taken in fluorescent lights, for
example.
The lenses in all the cameras are
glass, not plastic, he said. More than
half the cameras — and all the 3
megapixel or better cameras — have
macro functions. The best models focus down to 4 inches, and the range of
focus is listed for each camera on the
Web site.
Page 9

Society news: Web page

Can you find yourself on the page?
By Helen Long
<liz@cipcug.org>
For the benefit of those of you who
donate empty ink cartridges to the club
for recycling, please check the Web
Site Behind The Scenes for March
2003. We have several pictures of the
process that George has to go through
along with the criteria for the acceptance of cartridges. It would make
George’s job much simpler if the few
simple guidelines were followed by all.
We will soon be entering a period of
time in our club when we will have to
start paying for our meeting place, and
recycling ink cartridges certainly does
help us out. Donations are needed.
This site can be quickly accessed

through the table of contents, under
the very first heading of Current
Events, at the bottom of that listing
(Recycling) and it will take you directly to the proper place for the information.
I am using some of the pictures

that Jerry sends me, whether I can
identify them or not, so please watch
the Club Photo and Behind the Scenes
pages for pictures with no name, and
let me know who they are.
I think it’s great to use photos to
show our club at work but sometimes I
need help in identification. Please have
a look and send a message to
liz@cipcug.org.
If you have forgotten the password
for the password protected pages, don’t
hesitate to call me at 642-6521 or Email me at liz@cipcug.org.
Don’t forget to scrounge around for
items to sell at the July Garage Sale. If
you need a table or want to share a ta ble, contact Jim Thornton at
jthorn@gte.net.

Beginner’s SIG

Do you know what’s on your computer?
Reported by John Weigle
This month’s SIG by Michael
Shalkey was delayed briefly because
we were missing a cable for the projector and Michael had to go get his own
computer. When everything was set
up, he covered the topic “Do You
Know What’s on Your Computer?”
He based the SIG on an article by
Kim Komando, “5 questions to answer
now about your PC,” which can be
found on her Web site at http://www.
komando.com/kolumns_show.asp?
showID=4113. Michael puts his SIGS
on the Web at www.geocities.com/
cipcug.
Much of the information you’ll
gather by answering the first question
might not be of much help to you, but
it might be just what a technician
needs if you have a problem. Here are
the questions:
1. Do you know exactly what is
inside your computer? Windows 98,
Me and XP include a program called
System Information, which will gather
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information about your system’s hardware resources, components, software
environment, Internet settings and Office 10 applications (this item won’t
appear on all systems). To find the
program, go to Start>Programs or All
Programs>Accessories>System Information. You can print the results by
going to File>Print. Several freeware
programs will also search out what’s
on your computer; with one of the best
being SISoftware Sandra 2002 Stan dard. The company Web site is http://
www.sisoftware.co.uk/index.html
2. Do you have a print out of all
your passwords? With the number of
password-protected Web sites and email accounts that many people have,
it’s easy to forget what password you
picked for any single one. Michael
noted, for example, that he checks 14
e-mail accounts per day. There’s another reason to write down passwords:
Something might happen to you, and
your spouse, conservator or executor
might need to be able to access your
information. The passwords list should
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also include the passwords for encrypted files or directories. Obviously,
pasting the password list to your computer defeats the purpose of passwords,
so you have to find a different spot.
Simply storing the list on the computer
doesn’t work either. What if the hard
drive crashes?
3. Do you have a backup? With
CDs and writeable drives at the cost
they are, there’s no reason not to have
a backup of at least your data files, Michael noted (but see the next questions
to understand why a full backup can
also be helpful). Kim’s original article
also sugges ts — as do many others —
that the backup be kept somewhere
other than at home, just in case the
worst happens (fire or theft of your
computer). At the least, Michael recommended backing up the registry
with Regedit (you might have to
search for it if you don’t find it on the
Programs list.) Use File>Export to
copy the registry, which probably
(Continued on page 11)
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More on Beginners SIG ...
(Continued from page 10)

won’t fit on a floppy disk. Michael
said he does this anytime he makes a
major change to his machine.
Windows XP doesn’t automatically install the Microsoft backup program, but it can be installed from the
Windows CD-ROM (search for
ntbackup.msi and click on its icon to
install). Numerous third-party programs are also available.
4. Do you have all your software
product keys? More and more software requires some kind of key to
load it on the machine. If you don’t
have the numbers, you might have to
buy new all new software, an expensive proposition. If you haven’t kept
the original packing, many programs
will show the registration number under the Help>About menu.
5. Do you know where all your
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software is located? If you don’t, you
need to do a full backup. But it’s better to have the original disks. Kim
wrote in the original column, “I can't
tell you how many sad stories I’ve
heard about missing discs. It’s bad
enough to lose your hard drive. Having to buy a new copy of Microsoft
Office would really be rubbing salt
into a wound.”

Before the presentation started,
one memb er asked how to restore the
speaker volume control to the taskbar.
Go to Start>Control Panel>Sounds
and Audio Devices.
The first tab will have a check box
to place the volume control in the
taskbar.

Keyboard shortcuts
Michael also covered several useful keyboard shortcuts:
Ctrl-W will close the current Web page window in Internet
Explorer.
Ctrl-N opens another Internet Explorer page.
Shift-Click opens a page in a new IE window (useful if you
want to check a link and keep the original page on the screen).
Alt-F4 closes a program (be sure you’ve saved everything, of
course).
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Program review

Quicken makes tracking money easy
By John Weigle
jweigle@vcnet.com
I’ve used Quicken products since
their DOS days and been quite happy
with the results, so I wasn’t surprised
that the 2003 Quicken Premier kept up
the product’s high standards. I hadn’t
planned to upgrade this year, but when
a review copy arrived, I decided to go
ahead and install it to see what it was
like.
Installation was simple, and converting my old Quicken files proceeded without a hitch. Like most
well-written programs, Quicken suggests you back up your data files just in
case. Because I have an automatic
backup program (PowerQuest Data
Keeper, which comes with Partition
Magic), I continued the installation
(without problems).
I installed the new version knowing that I hadn’t updated my checking
account in quite a while, but not realizing until I opened the account in the
new version of Quicken that it had
been a full year since I had entered any
checks. Fortunately, the program arrived in October, giving me plenty of
time before taxes to enter all the new
information.
The program guides users through
a brief interview and helps you set up
accounts if you’re a new user. Quicken
tracks any number of accounts of different types at different kinds of finan cial institutions. And at tax time, TurboTax, the Intuit tax product, can import information from Quicken.
The setup will also point you to
features of Quicken that you’ve either
never used in older versions or that are
new to this one.
As usual, putting in the check in formation is easy. Quick keys allow a
lot of the information, such as the
check number and date, to be entered
with only one or two strokes. Once
you’ve written some checks — and I
had a lot to work with — Quicken
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This is the opening Quicken screen.
guesses after only a few letters the
name that should be placed in the Pay
to box and inserts the amount of the
last check to that person or company
along with the category. A list pops up
to let you choose the right payee if several start with the same name (such as
Wells Fargo Home Mortgage and
Wells Fargo Bank).
If you want to track several categories in a payment or deposit, Quicken
lets you do that (for instance, I can
track all the withholding, insurance
payments and other deductions from
my paycheck).
I regularly use only a small part of
Quicken. It offers, among other things
investing alerts, tax-smart investing
insights, Schedules A, B and D for
taxes, an investment sale optimizer,
investor’s reference guide, buy/sell
preview, capital gains YTD (year to
date) snapshot), scheduled online updates, guided setups for startup, bills
and more, and a new layout and look.
Intuit says the new layout is the
result of a multi-year research study. I
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found it a little disconcerting because I
was used to the old layout, but it’s not
a major problem.
Features of the new layout include
the following:
Account Bar, on the left hand side
of the home page: The bar provides
access to all accounts but allows balances to be hidden or visible. The
Quicken home page can be customized
to show any of more than 45 types of
charts, graphs and reports.
Account Centers, also on the left
side of the screen: They provide oneclick access to users’ finances in cash
flow, investing, property & debt (and
business in Premier Home & Business).
Tax & Planning Centers: Global
Centers, at the top right corner of the
screen, provide access to the Tax and
Planning Centers, which combine account data, tools, reports and informa tion from across all your finances related to planning and taxes.
(Continued on page 13)
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More on Quicken ...
(Continued from page 12)

As it has been for several years,
Quicken incorporates a lot of Internet
features. It lets you download account
information for credit cards and your
bank accounts from participating institutions.
This year, for the first time,
Quicken includes Quicken Brokerage
Powered by Siebert (that’s Muriel Siebert & Co. Inc., a discount brokerage
with more than 30 years experience).
The Quicken press package says,
“To g e t h e r, Quicken and Quicken
Brokerage powered by Siebert provide
the only unified financial management
solution that allows users to organize
their finances (including accounts at
other brokerages, mutual fund firms
and banks), receive proactive insights
about how they might do better, and

then take action to achieve their goals.
No other major online brokerage or
personal financial management software proactively does this today.”
The guide adds:
“Until now, personal finance software has helped you answer three
main questions:
“1. What do I have?
“2. How am I doing?
“3. How can I do better?
“Unfortunately, under that scenario, you’d be left at the precipice of
your decision and still have to go
somewhere else to execute the trade.
Until you take action, you still haven’t
improved your financial situation!
“On the other hand, financial services can help you take action, but with out consideration to your comprehensive financial picture.”

I haven’t used this feature so can’t
comment on how well it works.
Most of the computer magazines
say that Quicken and its main competitor, Microsoft Money, are comp arable, with the two periodically switching first and second place.
I’ve had no reason to switch from
Quicken until now, and the 2003 version doesn’t give me any reason to
change, either.
I highly recommend it if you have
no financial program and want one,
but I don’t know that I would change
if I was already accustomed to a different financial program.
System requirements:
Computer: IBM or compatible
Pentium 133 (Pentium II 300 recommended)

Quicken 2003 Product Line
Product Description
Retail Pricing*
Retail Rebate
Quicken 2003 Basic:
$29.95
N/A
Start organizing your personal finances with the basics
Balance your checkbook
Pay your bills
Track your spending
Quicken 2003 Deluxe: $59.95
Less $20 for previous Quicken owners
Manage your personal finances with easy, time -saving tools
Organize your finances
Monitor your investments
Prepare for tax time
Save for financial goals
Quicken 2003 Premier $79.95
Less $20 for previous Quicken owners
Optimize your personal finances with insightful and effective tools
Manage your finances easily
Optimize your investment portfolio
Maximize tax-saving opportunities
Plan and prepare for retirement
Quicken 2003 Premier Home & Business $89.95 Less $20 for previous Quicken owners
Includes the business features you need with the ease you want
Includes the complete Quicken Premier product
Create customizable invoices
Simplify business taxes
Track A/P and A/R
Prices are subject to change and may vary among retailers and distributors. Quicken 2003 is available on CD-ROM
through retail channels or directly from Intuit at www.quicken2003.com .
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More on no-hype digital photography ...
(Continued from page 9)

and f/ stop values between CCD and film cameras, how
light values were handled, etc. He got some answers, but I
think there were others that didn’t quite hit the mark. The
member asked about a Web site for information on these
topics. He was referred to only the Vivitar site and the Kodak site, as I recall.
I know of several good Web sites with information
about scanners and felt there must be some similar ones for
digital camera information — ones that were not just a re peat of the camera’s manual or reviews of the cameras. I
sent an e-mail off to the operator of the primary site on the
subject, Wayne Fulton, and he pointed me to a list of links
at the end of one of his long pages of links. The URL for
his site is <www.scantips.com>. We’ll look at some of
those shortly.
Another good site if you are working with small items
like coins or postage stamps is the one run by Peter G. Ait ken at <www.pgacon.com/tips_on_scanning.htm>. Peter
covers primarily scanning but has a brief section on digital
photography promoting his book, “Digital Camera Design
Guide.” It was published in 1997 and is now out of print.

He didn’t think much of digital photography when he
posted that site about six years ago — will have to ask
him if he has changed his mind at all. A browse on Amazon shows quite a few recent books on the subject. A
quick review of one is at the end of this article.
Now to what Wayne Fulton has. You go to <www.
scantips.com/scanlink.html#photo>, and scroll down and
down to his header of “About Digital Cameras, including
reviews.” There are six links. The first five go to review
sites of varying quality and currency. One has not been
changed since 2000. The sixth one returned a Not Found
report. But you may find them useful in seeing what people not related to a manufacturer have to say. (I should
note that I saw no reviews of any Vivitar camera.)
Somewhere in my browsing and clicking from his site
I clicked on a link to one that was a very pleasant surprise
compared to several that I had been looking at. It is
<www.shortcourses.com/>. In the second column is a link
to a Short Course page t itled, How do I do That? It takes
(Continued on page 15)

More on Quicken...
(Continued from page 13)

Minimum Memory: 32 MB RAM (64 MB RAM reco mmended)
Estimated Hard Disk Space: Basic: 62 MB; Deluxe: 66
MB; Premier: 67 MB; Premier Home & Business: 70 MB.
An additional 45 MB required for Microsoft Internet Explorer if IE 5.5 or higher is not already installed. (IE 5.5 is
included on Quicken CD-ROM).
Operating System: Windows 95/98/2000/Me/XP
Monitor: Super VGA (800x600) with 256 colors
(1024x768 with 16-bit color recommended)
Audio: Sound card and speakers recommended
CD-ROM Drive: 2X speed (4X speed or faster recommended for multimedia)
Internet Connection: 14.4 Kbps modem (56 Kbps or
higher recommended)
Printer: Any printer supported by Windows 95/98/2000/
Me/XP
Online Features: Internet access is required for all on line features, including online account access and online
payment.
Conversion: Quicken 2003 will convert all previous versions of Quicken for Windows. For additional in structions
on converting from different versions, visit the Quicken
support site at www.intuit.com/support/quicken.
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More on digital photography advice...
(Continued from page 14)

you to <www.shortcourses.com/how/
contents.htm>. Fig. 2 shows about half
the topics covered — there is another
full screen worth to scroll through.
I looked at several of the items, and
most all looked pretty informative,
though some were shorter than I would
have liked. The “Sites You Must See”
item at the lower left of Fig. 1 provides
a pretty good list of digital camera in formation sources. And some of those
also provide some links to learning
more on the topic.
One of the “Sites You Must See”
that has some useful instructional
pages is that by Digital Photography
Review at <www.dpreview.com>.
They have a very useful and interesting section that helps you learn quite a
bit more as well as provide reviews of
current and recent past digicams. I did
not have the luxury of time to look at
every one of these sites for which I
found links or to list in any detail what
information they had and rate them for
you. That is an exercise I leave to others. There are likely some others that
are better than these that I located.
What I have here is a start for your
own voyage of exploration and discovery.
I mentioned that there are now
many books about digital photography.

Figure 2: Just a few of the
many topics included in
the “How Do I Do That?”
part of the Short Courses
site.
One informative one that I know about
is from O’Reilly.
Priced at $14.95, “Digital Photography Pocket Guide” by Derrick Story
was released late last year. A nice part
is that the author uses information
from several camera brands and mo dels, rather than basing his information
on just one type — often a high-end
Nikon. He speaks about the differences
found between a compact camera, a

basic camera, an intermediate camera
and an advanced digital camera. From
the photos of cameras used to illustrate
various features of these devices, he
used a couple of Canons, a lower-end
Nikon, at least two from Olympus, and
one with a hot shoe (manufacturer unknown).
There are three main sections:
“What is it?”, What does it do?”
which is basically a very good glossary, and the one with all the tips,
“How do I...?” This part covers both
shooting tips and tricks and computer
tips and tricks. The images are gray
scale throughout, with no color comparisons, unfortunately, but what do
you want in a $15 book?
It does a lot to help you choose the
right settings for various situations,
and covers information ranging from
image resolution, to action and closeup photography, e-mailing photos and
also working with the images in programs such as PhotoShop 7.
This is available to all user group
members at 20 percent off the list price
by simply giving them their discount
code of DSUG when you order. The
book is listed on p. 64 of the catalog I
brought to the May meeting. It is their
Item No. 454-0, and is ISBN 0-59600454-0. The O’Reilly web site is at
<www.oreilly.com>.

W anted: Ad Manager
The Outer Edge needs someone
to sell ads in TOE to computercomputerrelated
businesses in the county. AnyAnyone
interested should co ntact Andy
Toth or John Weigle at any
meeting
or by ee-mail.

O’Reilly offers members of user groups a 20 percent discount on all its books
and conferences. If you’ve never checked out any O’Reilly books, go to the Web site at
www.oreilly.com to see what’s available. The order code is DSUG.
June 2003
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Society news: Membership report

Is it time for you to renew?
By Ken Church
membership@cipcug.org

Welcome to the following new members:
Roy Haggard & Kurt Moore
Attendance at the May 2003 general meeting:
92 Members
5 Guests
Total membership: 317
RENEWAL INFORMATION
The renewal/New Mbr dues are
$25/$35 for single membership,
$30/$50 for two or more family membership.
Please send your renewal payment to:
CIPCUG MEMBERSHIP
P.O. BOX 51354
OXNARD, CA 93031-1354
Or bring your payment to the June meeting.
April 2003 renewals:
Mbr#
Last Name
0776
Darnielle
1092
Davis
0439
Jeffreys
0142
Peck
1098A
Robles
1098
Robles
1098B
Robles
1062
Wolff
0966
Wright
0967
Wright
0863
Zapf

First Name
Jack
Paula
Robert
Darrell
Andrea
Daniel
Edward
Ray
Margaret
Ward
Michael

Pd to Date
200304
200304
200304
200304
200304
200304
200304
200304
200304
200304
200304

May 2003 renewals:
Mbr#
Last Name
1100
Baker
1100A
Baker
0207
Birkenshaw
1097
Dick
0549
Hafer
1099
Haney
0145
Lee
0331
Livingstone

First Name
Frank
Joyce
JJ
John
Dianne
Bill
Bill
Robert

Pd to Date
200305
200305
200305
200305
200305
200305
200305
200305
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1102
0922
0459

Morris
Neunuebel
Vanicek

June 2003 renewals:
Mbr#
Last Name
1064
Bazzell
0340
Burger
0456
Dinsmore
1103
Doucet
0878
Garner
0149T
Helton
1104
Hurd
0791
Komer
0148
Leventhal
0469
Magallanes
0580
McCoy
0929
McCoy
0146
Minkin
1065
Nicholes
1052
Norton
0225
Nunez
0342
Page
0473
Pittman
0472
Pittman
1101
Reed-Cardiff
0701
Romine
0593
Shalkey
0928
Sommers
0478
Stallman

Geri
Bob
Bob

200305
200305
200305

First Name
Gary
Lou
Bob
Bernadette
Bill
Charles
Shirley
Gene
Bob
CB
John
Tim
David
Mike
Cliff
Thomas
John
Barbara
Herman
Jo-Ann
Ned
Mike
Jacob
Betty

Pd to Date
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306
200306

If you don’t plan to renew, please
tell us why. If we’re doing something
wrong, we need to know what it is.
If you feel you’re missing something, be sure to check the advantages
of membership on page 19.
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F1—Your Help Key
(Revised March 9, 2003)
COMMUNICATIONS/INTERNET (GENERAL)
World Wide Web
DM, TS
Compuserve.
DM
Note Tab Pro.
TS
Procomm Plus
DM, WB
DATABASES
dBASE.

GM

DOS

RP

GM
DM, AT
DM

UTILITY PROGRAMS
Norton Utilities
PCAnywhere
PC Tools .
XTree Gold.

DM
DM
WB
DM

WORD PROCESSING
Microsoft Word
WordPerfect.

BW, DM, MR
DM, GM,

WINDOWS
Windows 3.1
Windows 98, 95
Windows Me
Windows 2000
Windows NT

DM, JM
DM, JM, AT (98)
JT, AT
TS, AT
TS

Init ials
AT

Name
Andy Toth

(805)
604-7538 (e)

BW
DM

Bart Wood
David Minkin

GM
JM
JT
MR
RP
TS

EDUCATIONAL / CHILDREN TZ
E-MAIL
Eudora
Lotus:CCMail.
Outlook
Outlook Express

SPREADSHEETS
Lotus 1-2-3
Microsoft Excel
Quattro Pro

JT
DM
TS, AT
TS, AT

TZ
WB

482-4993 (e)
469-6970 (cell) (5-11 p.m.
weekends);
dddave@QuixNet.net
Gracia Marks
484-7572 (e)
Jerry McLoud
(818) 889-6176 (e)
Jim Thornton
987-1748 (d)
Marvin Reeber
984-1974 (b)
Robert Provart
498-8477 (b)
Toby Scott
289-3960 (d)
tech@cipcug.org
Trish Zakas
985-8519 (b)
Dr. William Burger 653-6889 (e)

HARDWARE, UPGRADING JM
HTML

TS, AT

NETWORKS

TS

OFFICE SUITES
MS Office
Open Office
Star Office

AT
AT
AT

Phone: (d) = days; (e) = evenings; (b) = both
If you would like to volunteer to help others, please send
your contact information and programs you’re willing to
help on to <editor@cipcug.org>.

Practice safe computing:

Back up

Back up

Back up

(And then test the backup to be sure it worked)
June 2003
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Editor’s corner

Society news

Corrections, thanks
and more

Treasurer’s report
By Art Lewis

CORRECTION: As I’ve said before, having only one
pair of eyes look at The Outer Edge before it goes to press
sometimes leads to problems. In the last issue, I left a series
of x’s on the front page instead of listing the number of
members and visitors at the previous meeting. The numbers
were listed in the membership report, however.
THANKS: I hope you noticed the new nameplate on
the front page. Bob de Violini prepared a mock-up of his
idea and gave it to me at the last meeting, but the result
isn’t exactly what he had in mind because none of my programs could open his file properly. What we have is as
close as I could get with a scan and some additional playing
around with text boxes on top of art.
My strange mix of programs — some Office 97, Pub lisher 98 and Word XP — don’t always get along as well as
they should, which also explains why the membership re port looks different than it used to. When I had Word 97, it
would import Ken Church’s text and tables perfectly, but as
soon as I upgraded to Word 2002, I could no longer import
any Word documents into Publisher. Not even cut and paste
works on some of the documents, including Ken’s tables.
Unfortunately, if I upgrade Publisher, Helen Long must,
too, because she has to open the Pu blisher files to prepare
the PDF version of TOE that goes on the Web site.
A CORRECTION I WON’T HAVE TO MAKE: I
was all set to write a column complaining about an ISP that
adopted Web mail and installed a spam filter without bothering to tell its customers — but fortunately I found e-mails
the ISP had sent but I had missed. (Yes, I sent an apology
to the ISP for some of the comments I made in a phone call
asking about the issues.)
The change was a problem for me because e-mail I sent
to myself from work bounced back, saying my personal
mailbox at my ISP was full. I couldn’t understand that because I download my e-mail twice a day (except for a few
days after this was written because I’m suffering modem
trouble again). It turned out that the Spam folder and the
Trash folder on the server were full because I didn’t realize
I should have checked them and emptied them.
Assuming we can get that timing problem solved, I’ll
probably ask my ISP to reinstall the Spam filter on my ac count. I didn’t realize how much junk I wasn’t getting.
ONE MORE THING: No one asked, but I figured I
should explain why there was no column last month. We
just had too many items to run, and I thought everyone had
enough of my writing by the time I got here.

<treasurer@cipcug.org>
By Art Lewis

April 2003

<treasurer@cipcug.org>
Category Description
4-1 through
February 20034-30, 2003
Category
Description
2-1 through
INCOME
2-28, 2003
Donation
554.90
INCOME
ISP Income
1,165.00
ISPRaffle
Income
397.50
57.75
Renewals
805.00
Miscellaneous
Income
436.00 49.25
Software Sales
New
members
35.00
TOTAL INCOME
2,631.90
Raffle
EXPENSES
Renewals
Coffee-Doughnuts
TOTAL
INCOME
Corporate
Expenses

48.75
675.00
16.55
2,599.25
20.00

Equipment
750.75
EXPENSES
Insurance
-6.00
Coffee-Doughnuts
29.00
ISP Expense
523.00
Corporate
Expenses
34.00
Membership
37.00
ISPStorage
Expense
532.00
50.00
Software
253.38
TOE Purchase
442.78
Storage
50.00
TOTAL EXPENSES
1,903.27
TOE
794.05
TOTAL
EXPENSES
TOTAL
INCOME – EXPENSES 1,692.43
728.63
TOTAL INCOME – EXPENSES

906.82

Unrestricted Funds
$ 6,659.51
Unrestricted
$ 6,858.56
Restricted Funds
Funds
3,078.25
Restricted
Funds
3,752.50
Note: $750.75
transferred to Unrestricted Funds per CIPCUG
Board 4 -8-03
Bank Balance 4-31-03
9,737.76
Bank Balance 1-31-03
10,611.06

Tell our advertisers
you saw them in
The Outer Edge

— John Weigle, editor
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Why join Channel Islands PC
User Group (CIPCUG)?
Every month, members of the
Channel Islands PC User Group have
access to:
♦ The Outer Edge newsletter,
which includes a list of me mbers willing to help other
members
♦ The general meeting, featuring a question -and-answer
session and program on new
software or hardware
♦ Special Interest Groups —
special meetings held several
times a month on a variety of
topics
♦ Door prizes at the regular
meeting.
♦ The CIPCUG library of books
and videos.
Other benefits include:
♦ Special user group discounts
on books and software
♦ An Internet Service Provider
at a large discount (see be low).
♦ A chance to make friends with
people who have similar interests
♦ The ability to put your knowledge to good use by helping
other members. The whole
concept of user groups is
members helping members.

CIPCUG members are eligible to
sign up for the group’s Internet Service Provider (ISP) at the low price of
only $15 per month plus a $15 processing fee.
To sign up, contact one of the
club’s techies (see below). Call one of
them you may know or one in your
June 2003

area and they will be glad to provide
you with the details necessary for
signing up. Checks should be made
payable to CIPCUG and forwarded to
Treasurer, c/o CIPCUG, P. O. Box
51354, Oxnard CA 93031. Don’t forget to include the $15 set-up fee in
your first sign-up check. You may
make payments in three-month, sixmonth or annual increments. Renewals can also be mailed to Treasurer;
just be sure to mention the dates that
your check is to cover.
There is no program to install; you
will use programs that are already on
your computer. It’s simple to talk you
through the set-up, but if you’re the
least bit timid about setting up your
computer, a club member will come to
your house and make the necessary
arrangements. Our agreement will
also give you a 5 MB Web page allowance.
_________________________

Dues for new members
Individual member, $35.00
Family membership (same address), $50.00
Renewals are $25 and $30/yr.
respectively

CIPCUG INTERNET SERVICE
TECH TEAM
Jerry Crocker, 486-0308, 6-10 p.m.
normsplumb@aol.com,
Roland Fleig, 983-8707, mornings
schwable@cipcug.org,
George & Arline Lakes, 983-2969, 210 p.m.
thelakes@cipcug.org,
Helen Long, 642-6521
liz@cipcug.org
David D. Minkin, 469-6970, 5-12
p.m., weekends
dddave@QuixNet.net
Claude Whelchel, 482-4017, 8-noon
claude@cipcug.org
______________________________

ZIP Code:
_______________________________

CIPCUG MEMBERSHIP
APPLICATION
Amount enclosed:
____________________________
Please Print the following information:
Name:
_______________________________
Address:
_______________________________
City:
___________________________, CA

Phone no. (Home): _______________
(Work): _______________________
E-mail address:
_______________________________
User level: Novice _____; Intermediate _____; Advanced _____
Can you help the club as a volunteer?
If so, what would you be interested in
working on?
Date ___________________

Please clip last column and send
with payment to CIPCUG-Memb.
P.O. Box 51354, Oxnard, CA 930311354.
Please make checks payable to
CIPCUG

The Outer Edge

Member # ____________

Page 19

|

|

NON-PROFIT
U.S.POSTAGE
PAID
OXNARD. CA
PERMIT NO. 1785

The Outer Edge
Channel Islands PC Users Group
P.O.Box 51354
Oxnard, CA. 93031
DATED MATERIAL
Please Do Not Delay

DUES REMINDER
If the number after your
name is 0306, your membership dues are payable
in June 2003.

JUNE 2003 MEETING
OF CHANNEL ISLANDS PC USERS GROUP
101 Freeway

Camarillo Airport

N

This is
the Place
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y

Pleasant Valley Road

Fifth Street
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Saturday morning, June 7,
at
Freedom Center,
Camarillo Airport
515 Eubanks (at Pleasant Valley Road)
Camarillo, Calif.
Meeting Schedule:
0845-0930 Beginners SIG
0845-0930 Internet SIG
0930-1030 Business meeting, Q&A
1030-1055 Break - Please contribute requested
amounts for coffee & doughnuts
1100-1200 Program — Enigma II — and drawing

The Outer Edge

June 2003

Help your fellow members.
Volunteer to lead a SIG.
More details available from
Ralph Duchacek, Andy Toth,
Helen Long or Toby Scott at
any meeting.

Why join CIPCUG?
Here are just a few of the reasons:
Monthly SIGs, a monthly program, a
monthly newsletter, a discounted Internet Service Provider, a library of com-

Benefits of CIPCUG membe rship include:

If you’re looking for tips from other members,
check the CIPCUG Web page.

The Outer Edge, our
monthly 20-page newsletter
W anted: Advertising Manager
You might have noticed that advertising has fallen off in recent months. We need someone to talk
to computercomputer-related businesses about advertising in The Outer Edge. The editor’s job doesn’t alallow him to sell advertising for a competitor, even one as small as TOE. Anyone interested should
contact Andy Toth or John Weigle
Weigle at any meeting.
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